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Chapter 3  
Constructive Solid Geometry Concepts 

♦ Understand Constructive Solid 
Geometry Concepts 

♦ Create a Binary Tree 

♦ Understand the Basic Boolean 
Operations 

♦ Use the SolidWorks CommandManager 
User Interface 

♦ Setup GRID and SNAP Intervals 

♦ Understand the Importance of Order of 
Features 

♦ Use the Different Extrusion Options 
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Certified SolidWorks Associate Exam Objectives Coverage 
 

 

Sketch Entities – Lines, Rectangles, Circles, Arcs, Ellipses, 

Centerlines 
 Objectives:  Creating Sketch Entities. 

Rectangle Command ............................................... 3-11 

Circle Command ...................................................... 3-14 

 

 

Boss and Cut Features – Extrudes, Revolves, Sweeps, Lofts 
               Objectives:  Creating Basic Swept Features. 

Base Feature ............................................................. 3-10 

Reverse Direction Option ....................................... 3-16 

Hole Wizard ............................................................. 3-20 

 

 

Dimensions  
Objectives:  Applying and Editing Smart Dimensions.  

Reposition Smart Dimension .................................. 3-12 

 

 

Feature Conditions – Start and End  
Objectives:  Controlling Feature Start and End Conditions.  

Extruded Cut, Up to Next ....................................... 3-23 
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Introduction 
 

In the 1980s, one of the main advancements in solid modeling was the development of 

the Constructive Solid Geometry (CSG) method. CSG describes the solid model as 

combinations of basic three-dimensional shapes (primitive solids). The basic primitive 

solid set typically includes: Rectangular-prism (Block), Cylinder, Cone, Sphere, and 

Torus (Tube). Two solid objects can be combined into one object in various ways using 

operations known as Boolean operations. There are three basic Boolean operations: 

JOIN (Union), CUT (Difference), and INTERSECT. The JOIN operation combines 

the two volumes included in the different solids into a single solid. The CUT operation 

subtracts the volume of one solid object from the other solid object. The INTERSECT 

operation keeps only the volume common to both solid objects. The CSG method is also 

known as the Machinist’s Approach, as the method is parallel to machine shop 

practices. 
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Binary Tree 
 

The CSG is also referred to as the method used to store a solid model in the database. 

The resulting solid can be easily represented by what is called a binary tree. In a binary 

tree, the terminal branches (leaves) are the various primitives that are linked together to 

make the final solid object (the root). The binary tree is an effective way to keep track of 

the history of the resulting solid. By keeping track of the history, the solid model can be 

re-built by re-linking through the binary tree. This provides a convenient way to modify 

the model. We can make modifications at the appropriate links in the binary tree and re-

link the rest of the history tree without building a new model.   
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The Locator Design 
 

The CSG concept is one of the important building blocks for feature-based modeling. In 

SolidWorks, the CSG concept can be used as a planning tool to determine the number of 

features that are needed to construct the model. It is also a good practice to create 

features that are parallel to the manufacturing process required for the design. With 

parametric modeling, we are no longer limited to using only the predefined basic solid 

shapes. In fact, any solid features we create in SolidWorks are used as primitive solids; 

parametric modeling allows us to maintain full control of the design variables that are 

used to describe the features. In this lesson, a more in-depth look at the parametric 

modeling procedure is presented. The equivalent CSG operation for each feature is also 

illustrated.  

  

 

 

� Before going through the tutorial, on your own, make a sketch of a CSG binary tree 

of the Locator design using only two basic types of primitive solids: cylinder and 

rectangular prism. In your sketch, how many Boolean operations will be required to 

create the model? What is your choice of the first primitive solid to use, and why? 

Take a few minutes to consider these questions and do the preliminary planning by 

sketching on a piece of paper. Compare the sketch you make to the CSG binary tree 

steps shown on page 3-5. Note that there are many different possibilities in 

combining the basic primitive solids to form the solid model. Even for the simplest 

design, it is possible to take several different approaches to creating the same solid 

model.  
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Modeling Strategy – CSG Binary Tree  
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Starting SolidWorks and Activating the Command Manager 
 

1. Select the SolidWorks option on the Start menu or select the SolidWorks 
icon on the desktop to start SolidWorks. The SolidWorks main window will 

appear. 

2. Select the New icon with a 

single click of the left-mouse-button 

on the Menu Bar toolbar.  

 

3. Select the Part icon with a single click of the left-
mouse-button in the New SolidWorks Document dialog 

box. 

 

4. Select OK in the New SolidWorks Document dialog 

box to open a new part document. 

 

5. To turn ON the Command Manager, right 

click on any toolbar and toggle the Command 

Manager ON by selecting it at the top of the 

pop-up menu. 
 

� Notice the Features and Sketch toolbars no longer appear at the edge of the window.  
These toolbars appear on the Ribbon display of the Command Manager. 

 

 

Command Manager
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• Every object we construct in a CAD system is measured in units. We should 

determine the value of the units within the CAD system before creating the first 

geometric entities. For example, in one model, a unit might equal one millimeter 

of the real-world object; in another model, a unit might equal an inch. In most 

CAD systems, setting the model units does not always set units for dimensions. 

We generally set model units and dimension units to the same type and precision. 

 

6. Select the Options icon from the Menu Bar toolbar to open the Options dialog 

box. 

 

 

 

 

 

 

 

 

7. Select the Document Properties tab 
and the Drafting Standard option at the left 
of the Document Properties panel. 

 

 

 

 

8. Select ANSI in the pull-
down selection window under 

the Overall drafting standard 

panel as shown. 

 

 

 

 

9. Click Units as shown in the figure.   
 

 

10. Select MMGS (millimeter, gram, 
second) under the Unit system options. 
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11. Select None in the Decimals spin box for the Length units as shown to set the 
display to no decimal places. (Note the Overall Drafting Standard is automatically 

adjusted with our setting as shown.) 

 

GRID and SNAP Intervals Setup 
 

1. Click Grid/Snap as shown below.   

 

2. Check the Display grid checkbox under the Grid options.  
 

3. Uncheck the Dash checkbox under the Grid options. 
 

4. Set the Major grid spacing to 50 mm under the Grid options. 
 

5. Set the Minor-lines per major to 5 under the Grid options. 
 

6. Click OK in the Options dialog box to accept the selected 
settings. 
 

� Note that the above settings set the grid displaying in SolidWorks. Although the 

Snap to grid option is available in SolidWorks, its usage in parametric modeling is 

not recommended.  

1. Grid/Snap 

2. Check  

3. Uncheck 

4. Set to 50 mm

5. Set to 5 
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Base Feature 
 

In parametric modeling, the first solid feature is called the base feature, which usually 

is the primary shape of the model. Depending upon the design intent, additional features 

are added to the base feature.  

 

Some of the considerations involved in selecting the base feature are: 
 

• Design intent – Determine the functionality of the design; identify the feature that is 

central to the design. 

 

• Order of features – Choose the feature that is the logical base in terms of the order 

of features in the design. 

 

• Ease of making modifications – Select a base feature that is more stable and is less 

likely to be changed. 

 

� A rectangular block will be created first as the base feature of the Locator design. 
 

 

1. Select the Extruded Boss/Base button on the 
Features toolbar to create a new extruded feature.   

 

 

 

2. Move the cursor over the edge of the Top Plane in the graphics area.  When the 

Top Plane is highlighted, click once with the left-mouse-button to select the 

Top Plane (XZ Plane) as the sketch plane for the new sketch.  
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3. Select the Corner Rectangle command   by 

clicking once with the left-mouse-button on the 

icon in the Sketch toolbar. 

 

 

 

 

 

4. Create a rectangle of 
arbitrary size by 

selecting two locations 

on the screen as shown 

below.  

 

 

 

 

 

5. Inside the graphics window, click once with the 
right-mouse-button to bring up the option menu. 

 

6. Choose Select to end the Rectangle command. 

 

 

 

7. Select the Smart Dimension command 

by clicking once with the left-mouse-

button on the icon in the Sketch toolbar.  

 

 

8. The message “Select one or two edges/vertices and then a text location” is 

displayed in the Status Bar area at the bottom of the SolidWorks window. Select 

the bottom horizontal line by left-clicking once on the line. 

 
 

First Corner 

Second Corner 

8. Select the bottom 

horizontal line as the 

geometry to 

9.  Pick a location 

below the line to 

place the dimension. 

10.  Enter 75. 

11.  Click OK. 
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9. Move the graphics cursor below the selected line and left-click to place the 

dimension. (Note that the value displayed on your screen might be different than 

what is shown in the figure above.) 

 

10. Enter 75 in the Modify dialog box. 

 

11. Click OK in the Modify dialog box. 

 

 

12. On your own, create the vertical size dimension 

of the sketched rectangle as shown. Enter 50 to set the 
length of the line.  

 

13. Click on the OK icon to accept the entered 
value.  

 

 

14. Hit the [Esc] key once to end the Dimension command 

 

Repositioning Dimensions 
 

1. Move the cursor near the vertical dimension; note that the dimension is 

highlighted. Move the cursor slowly until a small marker appears next to the 

cursor, as shown in the figure. 

 

2. Drag with the left-mouse-button to reposition the selected dimension. 
 

3. Repeat the above steps to reposition the horizontal dimension. 

 

 

4. Click once with the left-mouse-button on the Exit Sketch 
icon on the Sketch toolbar to end the Sketch option. 
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Completing the Base Solid Feature 
 

• In the Extrude PropertyManager panel, enter 15 as the extrusion distance. 
Notice that the sketch region is automatically selected as the extrusion profile. 

 

• Click on the OK button to proceed with creating the 3D part.  
 

 

• Use the Viewing options to view 

the created part.  On the Heads-

up View toolbar, select View 
Orientation (to open the View 
Orientation pull-down menu) and 

select the Isometric icon to reset 
the display to the Isometric view 
before going to the next section.  

 

 

 

 

• Note the Extruded feature you created is listed in the 

Feature Manager Design Tree as shown.  Note the 

Design Tree can be used to identify all features used to 

create the design.   

4. Enter 15 

5. Click OK 
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Creating the Next Solid Feature 
 

1. Select the Extruded Boss/Base button on the 
Features toolbar to create a new extruded feature.  

 

 

 

 

2. Rotate the view by using the up arrow key to display the bottom face of the solid 

model as shown below. 

 

3. Pick the bottom face of the 3D model as the sketching plane. 

 

� Note that the sketching plane is aligned to 
the selected face.  

 

4. Select the Circle command by clicking 

once with the left-mouse-button on the 

icon in the Sketch toolbar. 
 

� We will align the center of the circle to the midpoint of the base feature. 

 

5. Move the cursor along the shorter edge of 

the base feature; when the midpoint is 

highlighted and the Midpoint sketch 
relation icon appears, click once with the 

left-mouse-button to select the midpoint. 

 

 

 

 

3. Pick the bottom face 

of the solid model. 
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6. Move the cursor over the corner of 

the base feature; when the corner is 

highlighted, click once with the left-

mouse-button to create a circle, as 

shown. 

 

7. Press the [Esc] key once to end the 
Circle command. 

 

 

 

 

 

8. Click once with the left-mouse-button on   

the Exit Sketch icon on the Sketch toolbar to 
exit the Sketch option. 

 

� Notice that the sketch region is       

            automatically selected as the extrusion  

            profile.  

 

 

9. Select the Isometric icon in the    
View Orientation pull-down menu. 

 

� Note that many other view-

related commands are also available 

under the View pull-down menu. 
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10. In the Extrude Property Manager panel, click the Reverse Direction icon to set 
the extrusion direction as shown below.   

 

11. In the Extrude PropertyManager panel, enter 40 as the extrusion distance. 
 

12. Confirm the Merge result checkbox is checked as shown. 
 

13. Click on the OK button to proceed with creating the extruded feature.  
 

• The two features are joined together 

into one solid part; the CSG-Union 

operation was performed.  This is 

the effect of the Merge result 

option. 

CSG Union 
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Creating an Extruded Cut Feature 
 

• We will create a circular cut as the next solid feature of the design. We will align 

the sketch plane to the top of the last cylinder feature.  

 

 

1. In the Features toolbar select the 
Extruded Cut command by clicking 

once with the left-mouse-button on the 

icon. 

 

 

 

 

2. Pick the top face of the cylinder as 
shown.  

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Select the Circle command by clicking 

once with the left-mouse-button on the 

icon in the Sketch toolbar. 

 

 

 

 

 

 

4. Move the cursor over the circular 

edge of the top face as shown.  (Do 

not click.)  Notice the center and 

quadrant marks appear on the circle. 

  

 

 

 

2. Pick the top face to 

align the sketch. 
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5. Select the Center point of the 
top face of the 3D model by 

left-clicking once on the icon 

as shown. 

 

6. Sketch a circle of arbitrary size 
inside the top face of the 

cylinder by left-clicking as 

shown.   

 

7. Use the right-mouse-button to 

display the option menu and 

choose Select in the popup 
menu to end the Circle 
command.  

 

 

 

 

 

 

8. Inside the graphics window, click once 
with the right-mouse-button to display the 

option menu. Select the Smart 
Dimension option in the popup menu. 

 

 

 

9. Create a dimension to 

describe the size of the 

circle and set it to 

30mm. 

 
 

 

 

 

 

 

 

10. Inside the graphics window, click once with the 
right-mouse-button to display the option menu. 

Choose Select in the popup menu to end the Smart 
Dimension command. 

 

11. Click once with the left-mouse-button on the Exit Sketch 
icon on the Sketch toolbar to exit the Sketch option. 

 

5. Select Center 

6. Draw Circle 



  Constructive Solid Geometry Concepts 3-19  

� The Cut-Extrude PropertyManager is displayed in the left panel.  Notice that the 

sketch region (the circle) is automatically selected as the extrusion profile. 

 

12. In the Cut-Extrude PropertyManager panel, click the arrow to reveal the pull-

down options for the End Condition (the default end condition is ‘Blind’) and 

select Through All as shown.  

 

13. Click the OK button (green check mark) in the Cut-Extrude PropertyManager 

panel. 

 

 

 

 

 

 

 

 

 

 

 

 

• The circular volume is removed 

from the solid model; the CSG-Cut 

operation resulted in a single solid. 

 

CSG Cut 

12. Through All 
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Creating a Hole with the Hole Wizard 
 

• The last cut feature we created is a sketched feature, where we created a rough 

sketch and performed an extrusion operation. We can also create a hole using the 

SolidWorks Hole Wizard. With the Hole Wizard, the hole feature does not need a 
sketch and can be created automatically. Holes, fillets, chamfers, and shells are all 

examples of features that do not require a sketch. 

 

1. In the Features toolbar, select the Hole Wizard command 

by clicking once with the left-mouse-button on the icon as 

shown.   

 

  

2. In the Hole Specification Property Manager, select 

the Positions panel by clicking once with the 
left-mouse-button on the Positions tab as shown.  
The Positions tab allows you to locate the hole on 
a planar or non-planar face.   

 

 

 

 

3. Move the cursor over the horizontal surface of the base feature.  Notice that the 

surface is highlighted.  Click the left mouse button to select a location inside the 

horizontal surface as the position for the hole. 

 

� Notice the Sketch toolbar is active and the Point button is now selected.  The Point 
command has been automatically executed to allow the insert of a point to serve as 

the center for the hole.  We will insert the point and use dimensions to locate it. 
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4. Move the cursor to a location on the 

horizontal surface of the base feature 

as shown and click the left mouse 

button to insert the point. 

 

 

 

 

 

 

 

5. Select the Smart Dimension command by clicking once 

with the left-mouse-button on the icon in the Sketch 

toolbar.  

 

6. Pick the center point by clicking once with the left-mouse-button as shown. 

 

7. Pick the right-edge of the top face of the base feature by clicking once with the 
left-mouse-button as shown. 

 

8. Select a location for the dimension by clicking once with the left-mouse-button 

as shown. 

 

9. Enter 30 in the Modify dialog box, and select OK. 
 

 

 

 

 

 

10. On your own, enter the additional 
dimension as shown (the dimension is 

25 mm). 

 

 

11. Press the [Esc] key once to end the 
Smart Dimension command. 

 

6.  7. 8. 
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12. In Hole Property Manager, select the Type panel by 
clicking once with the left-mouse-button on the Type tab 
as shown.   

 

 

 

13. Select the Hole icon under the Hole Specification option. 
(This is the default setting and is probably already 

selected.) 

 

 

 

14. Select Ansi Metric and Drill Size in the Standard option 
window. 

 

 

 

15. Set the Size option to a diameter of 20 mm. 

 

 

 

16. Set the End Condition option to Through All. 
 

 

 

 

17. Click the OK button (green check mark) in the Hole PropertyManager to 

proceed with the Hole feature.  

 

• The circular volume is removed from the solid model; the CSG-Cut operation 

resulted in a single solid. 

 

 

12. Select the Type tab.   

13. Select Hole button.  

14. Select Ansi Metric and Drill Size.  

16. Select Through All.  

CSG Cut 

15. Set to 20 mm.  
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Creating a Rectangular Extruded Cut Feature 
 

• Next create a rectangular cut as the last solid feature of the Locator. 
 

 

 

1. In the Features toolbar select the 
Extruded Cut command by clicking 

once with the left-mouse-button on the 

icon.   

 

 

 

 

2. Pick the right face of the base feature as shown. 

 
 
 
 
 
 
 

3. Select the Corner Rectangle command by 

clicking once with the left-mouse-button on the 

icon in the Sketch toolbar. 

 

 

 

4. Create a rectangle that is aligned to the top 
and bottom edges of the base feature as 

shown. 

 

 

 

 

 

 

 

5. On your own, create and modify the two 

dimensions as shown.  The dimensions are 15 
mm and 20 mm. 
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6. Click once with the left-mouse-button on the Exit Sketch 
icon on the Sketch toolbar to exit Sketch option.  
 

 

 

7. Select the Isometric icon in 
the View Orientation pull-down 

menu.  

 

� Note that many other view-

related commands are also 

available under the View pull-

down menu.  

 

 

8. In the Extrude Property Manager panel, click the arrow to reveal the pull-down 

options for the End Condition (the default end condition is Blind) and select Up 
To Next as shown.  

 

 

9. Click the OK button (green check mark) in the 

Cut-Extrude Property Manager panel. 
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Using the View Selector 
 

The View Selector provides an in-context method to select standard and non-standard 

views. 

1. Click on the View Orientation icon on the Heads-Up View Toolbar to reveal 
the view orientation options. 

 

2. Toggle the View Selector ON by left-clicking 
on the View Selector icon in the Orientation 
dialog box. 

 

� The View Selector appears in the graphics area.  
The View Selector provides an in-context method 

to select right, left, front, back, top, and isometric 

views of your model, as well as additional standard 

and isometric views.  

 

1. Select the View Orientation icon.   

2.  Toggle View Selector ON.   

CSG Cut
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3. Select the bottom isometric view on the View Selector as shown below.  Note 

the corresponding view appears. 

 

4. On your own, experiment with selecting other views using the View Selector.  

Notice that with the View Selector toggled ON, it automatically appears with the 

View Orientation option is selected on the Heads-Up View toolbar. 

 

5. Toggle the View Selector OFF by left-clicking on the 
View Selector icon in the Orientation dialog box. 

 

 

6. Hold down the [Ctrl] button and press the [Spacebar].  Notice the View Selector 
appears.  This is an alternate method to activate the View Selector. 
 

7. Select the isometric view as shown. 

 

 

8. Save the model with the name Locator. 
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Questions: 
 

1. List and describe three basic Boolean operations commonly used in computer 

geometric modeling software? 

 

2. What is a primitive solid? 

 

3. What does CSG stand for? 

 

4. Which Boolean operation keeps only the volume common to the two solid objects? 

 

5. What is the main difference between an EXTRUDED CUT feature and a HOLE 

feature in SolidWorks? 

 

6. Using the CSG concepts, create Binary Tree sketches showing the steps you plan to 
use to create the two models shown on the next page: 

  

Ex.1)     

 

 

 

 

 

 

 

 

 

 

 

 

Ex.2)    
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Exercises:  (All dimensions are in inches) 
 

1.     

 

2.  
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3.     

 

4.  

 
 


